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1. INTRODUCTION

The RCM3700 is a compact module that incorporates the latest

revision of the powerful Rabbit® 3000 microprocessor, flash
memory, onboard serial flash, static RAM, and digital 1/0 ports.

Throughout this manual, the term RCM3700 refers to the complete series of RCM3700
RabbitCore modules unless other production models are referred to specifically.

The RCM3700 has a Rabbit 3000 microprocessor operating at 22.1 MHz, static RAM,
flash memory, two clocks (main oscillator and real-time clock), and the circuitry necessary
for reset and management of battery backup of the Rabbit 3000’s internal real-time clock
and the static RAM. One 40-pin header brings out the Rabbit 3000 I/0O bus lines, parallel
ports, and serial ports.

The RCM3700 receives its +5 V power from the customer-supplied motherboard on
which it is mounted. The RCM3700 can interface with all kinds of CMOS-compatible
digital devices through the motherboard.

The Development Kit and the Ethernet Connection Kit have what you need to design your
own microprocessor-based system: a complete Dynamic C software development system
with optional modules and a Prototyping Board that acts as a motherboard to allow you to
evaluate the RCM3700 and to prototype circuits that interface to the RCM3700 module.

1.1 RCM3700 Features

« Small size: 1.20" x 2.95" x 0.98"
(30 mm x 75 mm x 25 mm)

= Microprocessor: latest revision of Rabbit 3000 running at 22.1 MHz supports Dynamic C
Secure Sockets Layer (SSL) module for added security

= 33 parallel 5V tolerant 1/0 lines: 31 configurable for 1/0O, 2 fixed outputs
= External reset 1/0

= Alternate 1/0 bus can be configured for 8 data lines and 5 address lines (shared with
parallel 1/O lines), I/O read/write

= Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers
* 512K flash memory and 512K SRAM (options for 256K flash memory and 128K SRAM)
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1 Mbyte serial flash memory, which is required to run the optional Dynamic C FAT file
system

Real-time clock

Watchdog supervisor

Provision for customer-supplied backup battery via connections on header J1
10-bit free-running PWM counter and four pulse-width registers

Two-channel Input Capture can be used to time input signals from various port pins

Two-channel Quadrature Decoder accepts inputs from external incremental encoder
modules

Four available 3.3 V CMOS-compatible serial ports: maximum asynchronous baud rate
of 2.76 Mbps. Three ports are configurable as a clocked serial port (SPI), and one port
is configurable as an HDLC serial port. Shared connections to the Rabbit microproces-
sor make a second HDLC serial port available at the expense of two of the SPI configu-
rable ports, giving you two HDLC ports and one asynchronous/SPI serial port.

Supports 1.15 Mbps IrDA transceiver

There are three RCM3700 production models. Table 1 below summarizes their main

features.
Table 1. RCM3700 Features
Feature RCM3700 RCM3710 RCM3720
Microprocessor Rabbit 3000® running at 22.1 MHz
Flash Memory 512K 256K 512K
SRAM 512K 128K 256K
Serial Flash Memory 1 Mbyte
4 shared high-speed, 3.3 V CMOS-compatible ports:
all 4 are configurable as asynchronous serial ports;
. 3 are configurable as a clocked serial port (SPI) and 1 is configurable as
Serial Ports . ]
an HDLC serial port;
option for second HDLC serial port at the expense of 2 clocked serial
ports (SPI)

The RCM3700 is programmed over a standard PC serial port through a programming cable
supplied with the Development Kit or the Ethernet Connection Kit, and can also be pro-
gramed through a USB port with an RS-232/USB converter or over an Ethernet with the
RabbitLink (both available from Rabbit).

Mounting holes were introduced on opposite corners of the RCM3700 in 2009.

Appendix A provides detailed specifications for the RCM3700.
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1.2 Advantages of the RCM3700

Fast time to market using a fully engineered, “ready-to-run/ready-to-program” micro-
processor core.

Competitive pricing when compared with the alternative of purchasing and assembling
individual components.

Easy C-language program development and debugging

Rabbit Field Utility to download compiled Dynamic C .bin files, and cloning board
options for rapid production loading of programs.

Generous memory size allows large programs with tens of thousands of lines of code,
and substantial data storage.

Integrated Ethernet port for network connectivity, with royalty-free TCP/IP software.

Ideal for network-enabling security and access systems, home automation, HVAC
systems, and industrial controls
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1.3 Development and Evaluation Tools

1.3.1 Development Kit

The Development Kit contains the hardware and software needed to use the RCM3700.
= RCM3700 module.

RCM3700 Prototyping Board.

Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z.,
U.K., and European style plugs).

Programming cable with 10-pin header and DE9 connections, and integrated level-
matching circuitry.

Cable kits to access RS-485 and analog input connectors on Prototyping Board.

Dynamic C CD-ROM, with complete product documentation on disk.

Getting Started instructions.

Accessory parts for use on the Prototyping Board.

Rabbit 3000 Processor Easy Reference poster.

Registration card.

Programming sﬁ GA I
DIAG Cable Universal
AC Adapter

with Plugs

[PROq] & I L I L
m Accessory Parts for

Prototyping Board Wiring Cable Kits

RabbitCore RCM3700

Getting Started
Instructions

Figure 1. RCM3700 Development Kit
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1.3.2 Software

The RCM3700 is programmed using version 8.11 or later of Dynamic C. Dynamic C v. 9.60
includes the popular uC/OS-I1 real-time operating system, point-to-point protocol (PPP),
FAT file system, Rabbit\Web, and other select libraries that were previously sold as indid-
ual Dynamic C modules.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure
Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-
tion to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support subscription is also available for purchase. Visit our Web site at
www.rabbit.com for further information and complete documentation, or contact your
Rabbit sales representative or authorized distributor.

1.3.3 Application Kits

Rabbit also has application Kits featuring the RCM3700 to provide the exact software and
other tools that will enable to tailor your RCM3700 for specific applications.

= Secure Embedded Web Application Kit (Rabbit Part No. 101-0898)—comes with three
CD-ROMs that have the Dynamic C RabbitWeb, FAT File System, and Secure Sockets
Layer (SSL) modules, and includes Dynamic C 8.51 or a later version and an
RCM3700. This enhanced software bundle facilitates the rapid development of secure
Web browser interfaces for embedded system control. Appendix E provides additional
information about the Secure Embedded Web Application Kit.

= Ethernet Connection Kit (Rabbit Part No. 101-0964)—comes with one CD-ROM that
includes Dynamic C 9.01 or a later version, an RCM3720 module, and an RCM3720
Prototyping Board. This kit is intended to demonstrate and help you develop Ethernet-
based applications.

Visit our Web site at www.rabbit.com or contact your Rabbit sales representative or autho-
rized distributor for further information.

1.3.4 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, use your browser to find and load default.htm in the docs
folder, found in the Dynamic C installation folder.

Each Dynamic C module has complete documentation available with the online documen-
tation described above.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.
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2. GETTING STARTED

This chapter describes the RCM3700 hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: Itisassumed that you have the RCM3700 Development Kit. If you purchased an
RCM3700 module by itself, you will have to adapt the information in this chapter and
elsewhere to your test and development setup.

2.1 Step 1 — Install Dynamic C

To develop and debug programs for the RCM3700 (and for all other Rabbit hardware), you
must install and use Dynamic C.

If you have not yet installed Dynamic C version 8.11 (or a later version), do so now by
inserting the Dynamic C CD from the RCM3700 Development Kit in your PC’s CD-ROM
drive. If autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows
Start | Run menu or Windows Disk Explorer to launch setup . exe from the root folder
of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the
process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system.
The installation allows you to choose the COM port that will be used. The default selec-
tion is COML. You may select any available port for Dynamic C’s use. If you are not cer-
tain which port is available, select COML. This selection can be changed later within
Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-
fying a port in use by another device (mouse, modem, etc.) may lead to a message such
as "could not open serial port'™ when Dynamic C is started.

Once your installation is complete, you will have up to three icons on your PC desktop.
One icon is for Dynamic C, one opens the documentation menu, and the third is for the
Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing
Dynamic C. The modules may be installed in any order. You must install the modules in
the same directory where Dynamic C was installed.

RabbitCore RCM3700 User’s Manual 9



2.2 Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the
sample programs:

1. Attach the RCM3700 module to the Prototyping Board.

2. Connect the programming cable between the RCM3700 and the COM port on the
workstation PC.

3. Connect the power supply to the Prototyping Board.

The connections are shown for the RCM3700 Prototyping Board, and are similar for the
RCM3720 Prototyping Board.

2.2.1 Step 1 — Attach Module to Prototyping Board

Turn the RCM3700 module so that the Ethernet jack is on the left as shown in Figure 2
below. Insert the module’s J1 header into the TCM_SMT_SOCKET socket on the Proto-
typing Board. The shaded corner notch at the bottom right corner of the RCM3700 module
should face the same direction as the corresponding notch below it on the Prototyping
Board.

Align shaded
corners

RCM3700

i

B

YO0

YOOOK

OO0

X

YXOOOO
C
YO

O
X0

X
Q

YOO
76
OO«

YO

X

X
X

O
(@}e;

X

O«

00000000000000Q., |
00000000000000
000000000000
Q00000000000
0000000000000
0000000000000
Q0000000000000 |
00000000000000
Q0000000000000
Q0000000000000
Q0000000000000
00000000000000
Q0000000000000
Q0000000000000
Q0000000000000 *

3

Figure 2. Install the RCM3700 Series on the Prototyping Board

NOTE: Itis important that you line up the pins on header J1 of the RCM3700 module
exactly with the corresponding pins of the TCM_SMT_SOCKET socket on the Proto-
typing Board. The header pins may become bent or damaged if the pin alignment is off-
set, and the module will not work. Permanent electrical damage to the module may also
result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board headers.
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2.2.2 Step 2— Connect Programming Cable

The programming cable connects the RCM3700 to the PC running Dynamic C to down-
load programs and to monitor the RCM3700 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on
the RCM3700 as shown in Figure 3. Be sure to orient the marked (usually red) edge of the
cable towards pin 1 of the connector. (Do not use the DIAG connector, which is used for a
normal serial connection.)

Standard @ Remove slot cover,
Programming Line up colored edge insert tabinto slot . AC Adapter
Cabl i

with dot 4 feElill
L' AC Adapter
Snap plug into place
7 @ p plug into pl

Ethernet Connection Kit
Programming
Cable

power connector

SO0
Jolelele]

. Reset switch

Figure 3. Connect Programming Cable and Power Supply

NOTE: Never disconnect the programming cable by pulling on the ribbon cable.
Carefully pull on the connector to remove it from the header.

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this
Development Kit—the programming cable has blue shrink wrap around the RS-232 con-
verter section located in the middle of the cable. The simplified programming cable and
adapter board that are supplied with the Ethernet Connection Kit may also be used as
shown in the inset diagram above. Programming cables from other Rabbit Kits are not
designed to work with RCM3700 modules.

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use
an RS-232/USB converter (Part No. 20-151-0178) with the programming cables men-
tioned above. Note that not all RS-232/USB converters work with Dynamic C.

RabbitCore RCM3700 User’s Manual 11



2.2.3 Step 3 — Connect Power

When all other connections have been made, you can connect power to the Prototyping
Board.

First, prepare the AC adapter for the country where it will be used by selecting the plug.
The RCM3700 Development Kit presently includes Canada/Japan/U.S., Australia/N.Z.,
U.K., and European style plugs. Snap in the top of the plug assembly into the slot at the
top of the AC adapter as shown in Figure 3, then press down on the spring-loaded clip
below the plug assembly to allow the plug assembly to click into place.

Connect the AC adapter to 3-pin header J4 on the Prototyping Board as shown in Figure 3.
The connector may be attached either way as long as it is not offset to one side.

Plug in the AC adapter. The LED above the RESET button on the Prototyping Board
should light up. The RCM3700 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow a hardware reset
without disconnecting power.

To power down the Prototyping Board, unplug the power connector from J4. You should
disconnect power before making any circuit adjustments in the prototyping area, changing
any connections to the board, or removing the RCM3700 from the Prototyping Board.

2.2.3.1 Overseas Development Kits

Development kits sold outside North America before 2009 included a header connector
that could be connected to 3-pin header J4 on the Prototyping Board. The connector could
be attached either way as long as it was not offset to one side. The red and black wires
from the connector could then be connected to the positive and negative connections on
your power supply. The power supply should deliver 7.5 V=30 V DC at 500 mA.
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2.3 Starting Dynamic C

Once the RCM3700 is connected as described in the preceding pages, start Dynamic C by
double-clicking on the Dynamic C icon on your desktop or in your Start menu.

If you are using a USB port to connect your computer to the RCM3700, choose Options >
Project Options and select “Use USB to Serial Converter.” You may have to determine
which COM port was assigned to the RS-232/USB converter. Click OK.

2.4 Run a Sample Program

Use the File menu to open the sample program PONG. C, which is in the Dynamic C
SAMPLES folder. Press function key F9 to compile and run the program. The STDIO
window will open on your PC and will display a small square bouncing around in a box.

This program shows that the CPU is working.
2.4.1 Troubleshooting

If Dynamic C cannot find the target system (error message ‘No Rabbit Processor
Detected."):

« Check that the RCM3700 is powered correctly — the red power lamp on the Prototyping
Board should be lit when the RCM3700 is mounted on the Prototyping Board and the AC
adapter is plugged in.

= Check both ends of the programming cable to ensure that they are firmly plugged into
the PC and the PROG connector, not the DIAG connector, is plugged in to the program-
ming port on the RCM3700 with the marked (colored) edge of the programming cable
towards pin 1 of the programming header.

= Ensure that the RCM3700 module is firmly and correctly installed in its connectors on
the Prototyping Board.

= Dynamic C uses the COM port specified during installation. Select a different COM
port within Dynamic C. From the Options menu, select Project Options, then select
Communications. Select another COM port from the list, then click OK. Press
<Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C still reports it is
unable to locate the target system, repeat the above steps until you locate the COM port
used by the programming cable.
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If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load the sample program, it is possible that
your PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

= Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

= Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Choose a lower debug baud rate.

2.5 Where Do | Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to
develop your own applications. The source code for the sample programs is provided to allow
you to modify them for your own use. The RCM3700 User’s Manual also provides
complete hardware reference information and describes the software function calls for the
RCM3700, the Prototyping Board, and the optional LCD/keypad module.

For advanced development topics, refer to the Dynamic C User’s Manual, also in the
online documentation set.

2.5.1 Technical Support

NOTE: If you purchased your RCM3700 through a distributor or through a Rabbit partner,
contact the distributor or partner first for technical support.

If there are any problems at this point:
= Use the Dynamic C Help menu to get further assistance with Dynamic C.

= Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/
and at www.rabbit.com/forums/.

= Use the Technical Support e-mail form at www.rabbit.com/support/.
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3. RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM3700 (and for all
other Rabbit hardware), you must install and use Dynamic C.

3.1 Introduction

To help familiarize you with the RCM3700 modules, Dynamic C includes several sample
programs. Loading, executing and studying these programs will give you a solid hands-on
overview of the RCM3700’s capabilities, as well as a quick start with Dynamic C as an
application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of the C
programming language. If you do not, see the introductory pages of the Dynamic C
User’s Manual for a suggested reading list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM3700 must be plugged in to the Prototyping Board as described in Chapter 2,
“Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header (J2) on the RCM3700
to your PC.

4. Power must be applied to the RCM3700 through the Prototyping Board.
Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu, then compile and run it by pressing
F9. The RCM3700 must be connected to a PC using the programming cable.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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The default 1/0O configuration in the sample programs is based on the RabbitCore module
detected during compile time:

« Any RCM3700 RabbitCore module (except the RCM3720) will have its 1/0 ports con-
figured for an RCM3700 Prototyping Board.

= An RCM3720 RabbitCore module will have its 1/0 ports configured for an RCM3720
Prototyping Board.

You may override these default settings to run an RCM3720 RabbitCore module on the
RCM3700 Prototyping Board or to run another RCM3700 RabbitCore module on the
RCM3720 Prototyping Board by adding the following macro to the sample program you
will be running.

= To run an RCM3720 RabbitCore module on an RCM3700 Prototyping Board, add the
following macro at the top of the sample program you will be running.
#define RCM3700_PROTOBOARD

Sample programs that are specifically designed for the RCM3700 Prototyping Board
already have this macro included.

e To run an RCM3700 RabbitCore module (other than the RCM3720) on an RCM3720
Prototyping Board, add the following macro at the top of the sample program you will
be running.

#define RCM3720_PROTOBOARD
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3.2 Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the
RCM3700. Sample programs illustrating the general operation of the RCM3700, serial
communication, and the A/D converter on the Prototyping Board are provided in the
SAMPLES\RCM3700 and the SAMPLES\RCM3720 folders as shown in the table below. The

sample programs use the features available on the two Prototyping Boards.

Feature RCM37O§0I:1rr?jtotyping RCM372§0F;rrc()jtotyping
Sample Program Folder SAMPLES\RCM3700 SAMPLES\RCM3720
Digital 1/0 X X
IrDA Transceivers X
Serial Flash X X
Serial Communication X X
TCP/IP X X
A/D Converter X
LCD/Keypad Module X
Dynamic C FAT File System,
RabbitWeb, X x
SSL Modules

Each sample program has comments that describe the purpose and function of the pro-
gram. Follow the instructions at the beginning of the sample program. Note that the
RCM3700 must be installed on the Prototyping Board when using these sample programs.

TCP/IP sample programs are described in Chapter 6, “Using the TCP/IP Features.” Sample
programs for the optional LCD/keypad module that is used on the RCM3700 Prototyping
Board are described in Appendix C.

Additional sample programs are available online at www.rabbit.com/support/down-
loads/downloads_prod.shtml.

= DI10.c—Demonstrates the digital 1/O capabilities of the A/D converter on the Proto-
typing Board by configuring two lines to outputs and two lines as inputs on Prototyping
Board header JP4.

If you are using the RCM3700 Prototyping Board, install a 2 x 2 header at JP4 and con-
nect pins 1-2 and pins 3—4 on header JP4 before running this sample program.

e FLASHLED.c—Demonstrates assembly-language program by flashing LEDs DS1 and
DS2 on the Prototyping Board at different rates.

= TOGGLESWITCH.c—Uses costatements to detect switches using debouncing. The cor-
responding LEDs (DS1 and DS2) will turn on or off.
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= CONTROLLED.c—Demonstrates use of the digital inputs by having you turn the LEDs
on the Prototyping Board on or off from the STDIO window on your PC.

Once you compile and run CONTROLLED . C, the following display will appear in the
Dynamic C STDIO window.

=10 x|

<4« Proto-board LEDs ]
o5z 0ss= 054 OsE

OFF OFF OFF OFF

From PC kewboard:
Select 3=D53, 4=054, 5=055, &=0S& to toggle LEDs

4 Press "@° To Quit

Press “1” or “2” on your keyboard to select LED DS1 or DS2 on the Prototyping
Board. Then follow the prompt in the Dynamic C STDIO window to turn the LED on or
off.

* IR_DEMO.c—Demonstrates sending Modbus ASCII packets between two RCM3700
Prototyping Board assemblies with IrDA transceivers via the IrDA transceivers. Note
that this sample program will only work with the RCM3700 Prototyping Board.

First, compile and run this program on one Prototyping Board assembly, then remove
the programming cable and press the RESET button on the Prototyping Board so that
the first RabbitCore module is operating in the Run mode. Then connect the program-
ming cable to the second Prototyping Board assembly with the RCM3700 and compile
and run the same sample program. With the programming cable still connected to the
second Prototyping Board assembly, press switch S1 on the second Prototyping Board
to transmit a packet. Once the first Prototyping Board assembly receives a test packet, it
will send back a response packet that will be displayed in the Dynamic C STDIO win-
dow. The test packets and response packets have different codes.

Once you have loaded and executed these five programs and have an understanding of
how Dynamic C and the RCM3700 modules interact, you can move on and try the other
sample programs, or begin building your own.
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3.2.1 Use of Serial Flash

The following sample programs can be found in the SAMPLES\RCM3700\Ser ialFlash
and the SAMPLES\RCM3720\SerialFlash folders.

e SERIAL_FLASHLOG.C—This program runs a simple Web server and stores a log of
hits on the home page of the serial flash *“server.” This log can be viewed and cleared
from a browser at http://10.10.6.100/. You may need to first “configure” your PC for a
“10Base-T Half-Duplex” or an “Auto-Negotiation” connection from the “Advanced”
tab, which is accessed from the control panel (Start > Settings > Control Panel) by
choosing Network Connections.

= SFLASH_INSPECT.C—This program is a handy utility for inspecting the contents of a
serialflash chip. When the sample program starts running, it attempts to initialize a
serial flash chip on Serial Port B. Once a serial flash chip is found, the user can perform
two different commands to either print out the contents of a specified page or clear (set
to zero) all the bytes in a specified page.

3.2.2 Serial Communication

The following sample programs can be found in the SAMPLES\RCM3700\SERIAL and the
SAMPLES\RCM3720\SERIAL folders.

NOTE: PE5 is set up to enable/disable the RS-232 chip on the RCM3700 Prototyping
Board. This pin will also be toggled when you run RS-232 sample programs on an
RCM3700 Prototyping Board. If you plan to use this pin for something else while you
are running any of the RS-232 sample programs, comment out the following line.

BitWrPortl (PEDR, &PEDRShadow, 0, 5);//set low to enable rs232 device

= FLOWCONTROL .C—This program demonstrates hardware flow control by configuring
Serial Port C for CTS/RTS with serial data coming from Serial Port D. The serial data
received are displayed in the STDIO window.

To set up the Prototyping Board, you will need to tie TxC and RxC
together on the RS-232 header at J2, and you will also tie TxD and
RxD together using the jumpers supplied in the Development Kit as
shown in the diagram.

ggggg

A repeating triangular pattern should print out in the STDIO window.
The program will periodically switch flow control on or off to demonstrate the effect of
no flow control.

Refer to the function description for serDflowcontrolon() in the Dynamic C
Function Reference Manual for a general description on how to set up flow-control
lines.
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= PARITY.C—This program demonstrates the use of parity modes by
repeatedly sending byte values 0-127 from Serial Port D to Serial Port
C. The program will switch between generating parity or not on Serial
Port D. Serial Port C will always be checking parity, so parity errors
should occur during every other sequence.

ngngng
&

To set up the Prototyping Board, you will need to tie TXxD and RxC together on the
RS-232 header at J2 using the 0.1" jumpers supplied in the Development Kit as shown
in the diagram.

The Dynamic C STDIO window will display the error sequence.

e SIMPLE3WIRE.C—This program demonstrates basic RS-232 serial
communication. Lower case characters are sent by TxC, and are nencme
received by RxD. The characters are converted to upper case and are J2 @@
sent out by TxD, are received by RxC, and are displayed in the T
Dynamic C STDIO window.

oooooo

To set up the Prototyping Board, you will need to tie TXD and RxC together on the
RS-232 header at J2, and you will also tie RxD and TxC together using the 0.1" jump-
ers supplied in the Development Kit as shown in the diagram.

e SIMPLESWIRE.C—This program demonstrates 5-wire RS-232 serial communication
with flow control on Serial Port C and data flow on Serial Port D.

To set up the Prototyping Board, you will need to tie TxD and RxD
together on the RS-232 header at J2, and you will also tie TxC and
RxC together using the 0.1" jumpers supplied in the Development Kit
as shown in the diagram.

ﬁﬁﬁﬁﬁ
2 X x X 3z

Once you have compiled and run this program, you can test flow con-

trol by disconnecting TxC from RxC while the program is running. Characters will no
longer appear in the STDIO window, and will display again once TxC is connected
back to RxC.

e SWITCHCHAR.C—This program transmits and then receives an ASCII string on Serial
Ports C and E. It also displays the serial data received from both ports in the STDIO
window.

Before running this sample program, check to make sure that Serial

Port E is set up as an RS-232 serial port—pins 1-3 and pins 2-4 on J2
header JP2 on the Prototyping Board must be jumpered together using Seee

ooooo

the 2 mm jumpers supplied in the Development Kit. Then connect TxC P2 -
to RXE and connect RxC to TxE on the RS-232 header at J2 using the —
0.1" jumpers supplied in the Development Kit as shown in the diagram.
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NOTE: The following two sample programs illustrating RS-485 serial communication
will only work with the RCM3700 Prototyping Board.

e SIMPLE485MASTER.C—This program demonstrates a simple RS-485 transmission of
lower case letters to a slave RCM3700. The slave will send back converted upper case
letters back to the master RCM3700 and display them in the STDIO window. Use
SIMPLE485SLAVE . C to program the slave RCM3700, and check to make sure that
Serial Port E is set up as an RS-485 serial port—pins 3-5 and pins 4—6 on header JP2
must be jumpered together using the 2 mm jumpers supplied in the Development Kit.

= SIMPLE485SLAVE.C—This program demonstrates a simple RS-485 -
transmission of lower case letters to a master RCM3700. The slave JP2
will send back converted upper case letters back to the master
RCM3700 and display them in the STDIO window. Use
SIMPLE485MASTER . C to program the master RCM3700, and check to make sure that
Serial Port E is set up as an RS-485 serial port—pins 3-5 and pins 4—6 on header JP2
must be jumpered together using the 2 mm jumpers supplied in the Development Kit.
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3.2.3 A/D Converter Inputs
The following sample programs are found in the SAMPLES\RCM3700\ADC folder.

AD_CALDIFF_CH.C—Demonstrates how to recalibrate one differential analog input
channel using two known voltages to generate the calibration constants for that channel.
Constants will be rewritten into user block data area.

Before running this program, make sure that pins 1-3 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. No pins are connected on header JP8.

AD_CALMA_CH.C—Demonstrates how to recalibrate an A/D input channel being used to
convert analog current measurements to generate the calibration constants for that channel.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. Connect pins 1-2, 3—-4, 5-6, 7-8 on header JP8.

AD_CALSE_ALL .C—Demonstrates how to recalibrate all single-ended analog input
channels for one gain, using two known voltages to generate the calibration constants
for each channel. Constants will be rewritten into the user block data area.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. No pins are connected on header JP8.

AD_CALSE_CHAN.C—Demonstrates how to recalibrate one single-ended analog input
channel with one gain using two known voltages to generate the calibration constants
for that channel. Constants will be rewritten into user block data area.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. No pins are connected on header JP8.

NOTE: The above sample programs will overwrite any existing calibration constants.

AD_RDDIFF_CH.C—Demonstrates how to read an A/D input channel being used for a
differential input using previously defined calibration constants.

Before running this program, make sure that pins 1-3 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. No pins are connected on header JP8.

AD_RDMA_CH.C—Demonstrates how to read an A/D input channel being used to con-
vert analog current measurements using previously defined calibration constants for
that channel.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. Connect pins 1-2, 3-4, 5-6, 7-8 on header JP8.

AD_RDSE_ALL .C—Demonstrates how to read all single-ended A/D input channels
using previously defined calibration constants.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. No pins are connected on header JP8.

RabbitCore RCM3700 User’s Manual 22



= AD_SAMPLE.C—Demonstrates how to use a low-level driver on single-ended inputs.
The program will continuously display the voltage (average of 10 samples) that is pres-
ent on the A/D channels.

Before running this program, make sure that pins 3-5 are connected on headers JP5,
JP6, and JP7 on the Prototyping Board. No pins are connected on header JP8.

= ANAINCONFI1G.C—Demonstrates how to use the Register Mode method to read single-
ended analog input values for display as voltages. The sample program uses the func-
tion call analnConfig() and the ADS7870 CONVERT line to accomplish this task.

Before running this program, make sure that pins 3-5 are connected on headers JP5, JP6,
and JP7 on the Prototyping Board. No pins are connected on header JP8. Also connect
PE4 on header J3 on the Prototyping Board to the CNVRT terminal on header J8.

If you use this sample program as a template for your own program, be aware that PE4
is also used for the IrDA FIR_SEL on the Prototyping Board. You will need to use
another parallel port line for the analog input if you are also using the IrDA transceiver.

e THERMISTOR.C—Demonstrates how to use analog input THERM _IN7 to calculate
temperature for display to the STDIO window. This sample program assumes that the
thermistor is the one included in the Development Kit whose values for beta, series
resistance, and resistance at standard temperature are given in the part specification.

Before running this program, install the thermistor into the AIN7 and AGND holes at
location J7 on the Prototyping Board.

Before running the next two sample programs, DNLOADCALIB. C or UPLOADCALIB.C,
connect your PC serial COM port to header J2 on the Prototyping Board as follows.

= Txto RxE

* Rxto TxE

< GND to GND

Then connect pins 1-3 and 2-4 on header JP2 on the Prototyping Board.

You will need to run a serial utility such as Tera Term on your PC. You may download
Tera Term from hp.vector.co.jp/authors/\VVA002416/teraterm.html. Once Tera Term is run-
ning, configure the serial parameters as follows.

= Baud rate 19200, 8 bits, no parity, and 1 stop bit.
= Enable the "Local Echo" option.
= Set the line feed options to Receive = CR and Transmit = CR + LF.

Now press F9 to compile and run this program. Verify that the message "Waiting,

Please Send Data file" is being display in Tera Term display window before proceeding.
From within Tera Term, select File > Send File > Path and filename, then select the
OPEN option within the dialog box. Once the data file has been downloaded, it will indi-
cate whether the calibration data were written successfully.
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= DNLOADCAL1B.C—Demonstrates how to retrieve analog calibration data to rewrite it
back to simulated EEPROM in flash with using a serial utility such as Tera Term.

= UPLOADCALIB.C—Demonstrates how to read calibrations constants from the user
block in flash memory and then transmitting the file using a serial port and a PC serial
utility such as Tera Term. Use DNLOADCAL 1B.C to download the calibration constants
created by this program.
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4. HARDWARE REFERENCE

Chapter 4 describes the hardware components and principal hardware
subsystems of the RCM3700. Appendix A, “RCM3700 Specifica-
tions,” provides complete physical and electrical specifications.

Figure 4 shows the Rabbit-based subsystems designed into the RCM3700.

32 kHz || 11 MHz
Ethernet osc osc Customer-specific
applications
SRAM RABBIT® CMOS-level signals
Pll':c;g;?]m 3000 el
converter
Serial |
Flash Battery-Backup RS-232, RS-485, IrDA
Circuit serial communication
drivers on motherboard
= Customer-supplied
RabbitCore Module T external 3 V battery

Figure 4. RCM3700 Subsystems
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4.1 RCM3700 Digital Inputs and Outputs
Figure 5 shows the RCM3700 pinouts for header J1.

J1
PA6 | o m[ ] PA7
PAA[|c o[ 1 PA5
PA2(| o o[ PA3
PAO ] o o[ ] PA1
PFO[|c o[ JPF1
PB2[ |c o[ 1PBO
PB4[ |oc o[ 1PB3
PB7 |0 o[ 1PB5
PF5|o o[ PF4
PF7 o o[ PF6
PC1/PG2 |0 o[ ] PCO
PC3/PG3 |0 o[ JPC2
PE5S |0 o[ 1PE7
PE1|o o[ PE4
PG7 [ o o[ 1PEO
/IOWR |0 o[ 1PG6
PD4 ] o o[ ]/IORD
/RES| = =[] PD5
GND [ o o [1VBAT
GNDL] o o[ J+5V
Note: These pinouts are as seen on
the Bottom Side of the module.

Figure 5. RCM3700 Pinouts

Header J1 is a standard 2 x 20 IDC header with a nominal 0.1" pitch.
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Figure 6 shows the use of the Rabbit 3000 microprocessor ports in the RCM3700 modules.

PBO, PB7,
PAO-PAT PB2-PB5 PD4—PD5
Port D
Port A Port B (+Ethernet Port)

pco, P2 4@l portC -
PC1, PCm| (SerialPorts C&D) | SguY =TI N PE7

PG2-PG3 Port G 3000
PG6-PG7 H‘ (Serial Ports E & F) Port F PF4-PF7

PC6, STATUS Programming Real-Time Clock
PB1, PC7, /RESET, Port Watchdog

Port E

IRES
Serial Port A

SMODEO, SMODE1 ( ) 1 Timers Misc. 1/O /IORD

. ﬁ Ethernet Slave Port /RES

4 Ethernet signals [
9 Port Clock Doubler I IOWR

RAM Backup Battery Flash
Support

PEO-PE1,
PE4-PES,

Figure 6. Use of Rabbit 3000 Ports

The ports on the Rabbit 3000 microprocessor used in the RCM3700 are configurable, and
so the factory defaults can be reconfigured. Table 2 lists the Rabbit 3000 factory defaults

and the alternate configurations.
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Table 2. RCM3700 Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes
External data bus
IDO-ID7
1-8 PA[7:0] Parallel 1/0 ( ) External Data Bus
Slave port data bus
(SD0-SD7)
QD1A
9 PF1 Input/Output
nput/Outpu CLKC
QD1B
10 PFO Input/Output CLKD
11 PBO Input/Output CLKB
IAQ External Address 0
12 PB2 Input/Output .
pubutpu /SWR Slave port write
1ALl External Address 1
13 PB3 Input/Output /SRD Slave port read
1A2 External Address 2
14 PB4 Input/Output SAO Slave Port Address 0
IA3 External Address 3
. 15 PB5 Input/Output SA1l Slave Port Address 1
g IAS External Address 5
g 16 PBT Input/Output ISLAVEATTN Slave Port Attention
AQD1B
17 PF4 Input/Output PWMO
AQD1A
18 PF5 Input/Output PWML
AQD2B
1 PF |
9 6 nput/Output PWM?2
AQD2A
20 PF7 Input/Output PWM3
21 PCO Output TXD Serial Port D
Serial Port D
22 PC1/PG2 Input/Output RXD/TXF Serial Port E
23 PC2 Output TXC Serial Port C
Serial Port C
24 PC3/PG3 Input/Output RXC/RXF Serial Port F
17 1/0 Strobe 7
25 PEY Input/Output /SCS Slave Port Chip Select
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Table 2. RCM3700 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
26 PE5 Input/Output 1S 1/ Strobe 5
INT1B Interrupt 1B
14 1/O Strobe 4
27 PE4 Input/Output
pututpu INTOB Interrupt OB
11 1/0O Strobe 1
28 PE1 Input/Output
pututpu INT1A Interrupt 1A
10 1/0 Strobe 0
29 PEO Input/Output robe
INTOA Interrupt OA
30 PG7 Input/Output RXE
Serial Port E
= |31 PG6 Input/Output TXE
§ 32 /IOWR Output External write strobe
[«5)
T 33 /IORD Output External read strobe
34 PD4 Input/Output ATXB
Alternate Serial Port B
35 PD5 Input/Output ARXB
36 IRES Reset output Reset input Reset output from Reset
Generator
37 VBAT
38 GND
39 +5V
40 GND
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4.1.1 Memory /O Interface

The Rabbit 3000 address lines (A0-A18) and all the data lines (D0-D7) are routed inter-
nally to the onboard flash memory and SRAM chips. 1/0 write (/IOWR) and 1/0 read
(/IORD) are available for interfacing to external devices.

Parallel Port A can also be used as an external I/0O data bus to isolate external 1/0 from the
main data bus. Parallel Port B pins PB2-PB5 and PB7 can also be used as an external
address bus.

When using the external 1/0 bus for either Ethernet or the LCD/keypad module on the
Prototyping Board, or for any other reason, you must add the following line at the begin-
ning of your program.

#define PORTA_AUX_ 10 // required to enable external 1/0 bus
4.1.2 Other Inputs and Outputs

/RES is an output from the reset circuitry that can be used to reset other peripheral devices.
This pin can also be used to reset the microprocessor.
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4.2 Serial Communication

The RCM3700 board does not have any serial transceivers directly on the board. How-
ever, a serial interface may be incorporated on the board the RCM3700 is mounted on. For
example, the Prototyping Board has RS-232, RS-485 and IrDA transceiver chips.

4.2.1 Serial Ports

There are five serial ports designated as Serial Ports A, C, D, E, and F. All five serial ports
can operate in an asynchronous mode up to the baud rate of the system clock divided by 8.
An asynchronous port can handle 7 or 8 data bits. A 9th bit address scheme, where an
additional bit is sent to mark the first byte of a message, is also supported.

Serial Port A is normally used as a programming port, but may be used either as an asyn-
chronous or as a clocked serial port once application development has been completed and
the RCM3700 is operating in the Run Mode.

Serial Ports C and D can also be operated in the clocked serial mode. In this mode, a clock
line synchronously clocks the data in or out. Either of the two communicating devices can
supply the clock.

Serial Ports E and F can also be configured as HDLC serial ports. The IrDA protocol is
also supported in SDLC format by these two ports.

Serial Port F shares its pins with Serial Ports C and D on header J1, as shown in Figure 7.
The selection of port(s) depends on your need for two clocked serial ports (Serial Ports C
and D) vs. a second HDLC serial port (Serial Port F).

Figure 7. RCM3700 Serial Ports C, D, and F

The serial ports used are selected with the serXOpen function call, where X is the serial
port (C, D, or F). Remember that RxC and RxD on Serial Ports C and D cannot be used if
Serial Port F is being used
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4.2.2 Ethernet Port

Figure 8 shows the pinout for the RJ-45 Ethernet port (J3). Note that some Ethernet con-
nectors are numbered in reverse to the order used here.

ETHERNET
' 1@8
1. E_Tx+
2. E_Tx—
3. E_Rx+
6. E_Rx-
RJ-45 Plug RJ-45 Jack

Figure 8. RJ-45 Ethernet Port Pinout

Two LEDs are placed next to the RJ-45 Ethernet jack, one to indicate an Ethernet link
(LINK) and one to indicate Ethernet activity (ACT).

The RJ-45 connector is shielded to minimize EMI effects to/from the Ethernet signals.
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4.2.3 Serial Programming Port

The RCM3700 programming port is accessed through header J2 or over an Ethernet con-
nection via the RabbitLink EG2110. The programming port uses the Rabbit 3000’s Serial
Port A for communication. Dynamic C uses the programming port to download and debug
programs.

The programming port is also used for the following operations.
= Cold-boot the Rabbit 3000 on the RCM3700 after a reset.

= Remotely download and debug a program over an Ethernet connection using the
RabbitLink EG2110.

= Fast copy designated portions of flash memory from one Rabbit-based board (the
master) to another (the slave) using the Rabbit Cloning Board.

In addition to Serial Port A, the Rabbit 3000 startup-mode (SMODEO, SMODEL), status,
and reset pins are available on the programming port.

The two startup mode pins determine what happens after a reset—the Rabbit 3000 is
either cold-booted or the program begins executing at address 0x0000.

The status pin is used by Dynamic C to determine whether a Rabbit microprocessor is
present. The status output has three different programmable functions:

1. It can be driven low on the first op code fetch cycle.
2. It can be driven low during an interrupt acknowledge cycle.
3. It can also serve as a general-purpose CMOS output.

The /RESET _IN pin is an external input that is used to reset the Rabbit 3000 and the
RCM3700 onboard peripheral circuits. The serial programming port can be used to force a
hard reset on the RCM3700 by asserting the /RESET _IN signal.

Alternate Uses of the Programming Port

All three clocked Serial Port A signals are available as

= asynchronous serial port

= an asynchronous serial port, with the clock line usable as a general CMOS input

The programming port may also be used as a serial port once the application is running.
The SMODE pins may then be used as inputs and the status pin may be used as an output.

Refer to the Rabbit 3000 Microprocessor User’s Manual for more information.
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4.3 Serial Programming Cable

The programming cable is used to connect the programming port of the RCM3700 to a PC
serial COM port. The programming cable converts the RS-232 voltage levels used by the
PC serial port to the CMOS voltage levels used by the Rabbit 3000.

When the PROG connector on the programming cable is connected to the RCM3700 pro-
gramming port, programs can be downloaded and debugged over the serial interface.

The DIAG connector of the programming cable may be used on header J2 of the RCM3700
with the RCM3700 operating in the Run Mode. This allows the programming port to be
used as a regular serial port.

4.3.1 Changing Between Program Mode and Run Mode

The RCM3700 is automatically in Program Mode when the PROG connector on the pro-
gramming cable is attached, and is automatically in Run Mode when no programming
cable is attached. When the Rabbit 3000 is reset, the operating mode is determined by the
state of the SMODE pins. When the programming cable’s PROG connector is attached,
the SMODE pins are pulled high, placing the Rabbit 3000 in the Program Mode. When the
programming cable’s PROG connector is not attached, the SMODE pins are pulled low,
causing the Rabbit 3000 to operate in the Run Mode.

RESET RCM3700 when changing mode:

Press RESET button (if using Prototyping Board), OR
Cycle power off/on

after removing or attaching programming cable.

Programming
Fame | O

Colored
edge =

o000

Blue =
shrink wrap -,

To
PC COM port
i)

Figure 9. Switching Between Program Mode and Run Mode
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A program “runs” in either mode, but can only be downloaded and debugged when the
RCM3700 is in the Program Mode.

Refer to the Rabbit 3000 Microprocessor User’s Manual for more information on the pro-
gramming port and the programming cable.

4.3.2 Standalone Operation of the RCM3700

The RCM3700 must be programmed via the RCM3700 Prototyping Board or via a similar
arrangement on a customer-supplied board. Once the RCM3700 has been programmed
successfully, remove the programming cable from the programming connector and reset
the RCM3700. The RCM3700 may be reset by cycling the power off/on or by pressing the
RESET button on the Prototyping Board. The RCM3700 module may now be removed
from the Prototyping Board for end-use installation.

CAUTION: Power to the Prototyping Board or other boards should be disconnected
when removing or installing your RCM3700 module to protect against inadvertent
shorts across the pins or damage to the RCM3700 if the pins are not plugged in cor-
rectly. Do not reapply power until you have verified that the RCM3700 module is
plugged in correctly.
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4.4 Other Hardware
4.4.1 Clock Doubler

The RCM3700 takes advantage of the Rabbit 3000 microprocessor’s internal clock doubler.
A built-in clock doubler allows half-frequency crystals to be used to reduce radiated emis-
sions. The 22.1 MHz frequency specified for the RCM3700 is generated using a 11.06 MHz
resonator.

The clock doubler may be disabled if 22.1 MHz clock speeds are not required. This will
reduce power consumption and further reduce radiated emissions. Disable the clock
doubler by adding a simple configuration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.
2. Add the line CLOCK_DOUBLED=0 to always disable the clock doubler.

The clock doubler is enabled by default, and usually no entry is needed. If you need to
specify that the clock doubler is always enabled, add the line CLOCK_DOUBLED=1 to
always enable the clock doubler.

3. Click OK to save the macro. The clock doubler will now remain off whenever you are
in the project file where you defined the macro.

4.4.2 Spectrum Spreader

The Rabbit 3000 features a spectrum spreader, which helps to mitigate EMI problems. By
default, the spectrum spreader is on automatically, but it may also be turned off or set to a
stronger setting. The spectrum spreader settings may be changed through a simple config-
uration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.

2. Normal spreading is the default, and usually no entry is needed. If you need to specify
normal spreading, add the line

ENABLE_SPREADER=1
For strong spreading, add the line
ENABLE_SPREADER=2
To disable the spectrum spreader, add the line
ENABLE_SPREADER=0
NOTE: The strong spectrum-spreading setting is not recommended since it may limit

the maximum clock speed or the maximum baud rate. It is unlikely that the strong
setting will be needed in a real application.

3. Click OK to save the macro. The spectrum spreader will now be set to the state specified
by the macro value whenever you are in the project file where you defined the macro.

NOTE: Refer to the Rabbit 3000 Microprocessor User’s Manual for more information
on the spectrum-spreading setting and the maximum clock speed.
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4.5 Memory

45.1 SRAM

RCM3700 series boards have 256K-512K of SRAM.

4.5.2 Flash EPROM

RCM3700 series boards also have 256K-512K of flash EPROM.

NOTE: Rabbit recommends that any customer applications should not be constrained by
the sector size of the flash EPROM since it may be necessary to change the sector size
in the future.

Writing to arbitrary flash memory addresses at run time is also discouraged. Instead, use a
portion of the “user block” area to store persistent data. The functions writeUser-
Block and readUserBlock are provided for this. Refer to the Rabbit 3000 Micropro-
cessor Designer’s Handbook for additional information.

A Flash Memory Bank Select jumper configuration option based on 0 Q surface-mounted
resistors exists at header JP1 on the RCM3700 modules. This option, used in conjunction
with some configuration macros, allows Dynamic C to compile two different co-resident
programs for the upper and lower halves of the 512K flash in such a way that both pro-
grams start at logical address 0000. This is useful for applications that require a resident
download manager and a separate downloaded program. See Technical Note TN218 in the
online documentation, Implementing a Serial Download Manager for a 256K Flash, for
details.

4 5.3 Serial Flash

A 1Mbyte serial flash is available to store data and Web pages. Sample programs in the
SAMPLES\RCM3700 folder illustrate the use of the serial flash.

4.5.4 Dynamic C BIOS Source Files

The Dynamic C BIOS source files handle different standard RAM and flash EPROM sizes
automatically.
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5. SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Rabbit single-board computers and other
single-board computers based on the Rabbit microprocessor.
Chapter 5 describes the libraries and function calls related to the
RCM3700.

5.1 More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for program-
ming embedded systems, and features quick compile and interactive debugging. A com-
plete reference guide to Dynamic C is contained in the Dynamic C User’s Manual and in
the Dynamic C Function Reference Manual.

You have a choice of doing your software development in the flash memory or in the
SRAM included on the RCM3700. The flash memory and SRAM options are selected
with the Options > Compiler menu.

The advantage of working in RAM is to save wear on the flash memory, which is limited
to about 100,000 write cycles. The disadvantage is that the code and data might not both
fit in RAM.

NOTE: An application can be compiled in RAM, but cannot run standalone from RAM
after the programming cable is disconnected. All standalone applications can only run
from flash memory.

NOTE: Do not depend on the flash memory sector size or type in your program logic.
The RCM3700 and Dynamic C were designed to accommodate flash devices with
various sector sizes in response to the volatility of the flash-memory market.

Developing software with Dynamic C is simple. Users can write, compile, and test C and
assembly code without leaving the Dynamic C development environment. Debugging
occurs while the application runs on the target. Alternatively, users can compile a program
to an image file for later loading. Dynamic C runs on PCs under Windows 2000/NT and
later—see Rabbit’s Technical Note TN257, Running Dynamic C® With Windows Vista®,
for additional information if you are using a Dynamic C release prior to v. 9.60 under
Windows Vista. Programs can be downloaded at baud rates of up to 460,800 bps after the
program compiles.
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Dynamic C has a number of standard features. Some of these standard features are listed
below.

Full-feature source and assembly-level debugger, no in-circuit emulator required.
Royalty-free TCP/IP stack with source code and most common protocols.

Hundreds of functions in source-code libraries and sample programs:

P exceptionally fast support for floating-point arithmetic and transcendental functions.
» RS-232 and RS-485 serial communication.

» analog and digital 1/O drivers.

» 12C, SPI, GPS, file system.

» LCD display and keypad drivers.

Powerful language extensions for cooperative or preemptive multitasking

Loader utility program (Rabbit Field Utility) to load binary images to Rabbit-based tar-
gets without the presence of Dynamic C.

Provision for customers to create their own source code libraries and augment on-line
help by creating “function description” block comments using a special format for
library functions.

Standard debugging features:

» Breakpoints—Set breakpoints that can disable interrupts.
» Single-stepping—Step into or over functions at a source or machine code level, uC/OS-Il aware.

» Code disassembly—The disassembly window displays addresses, opcodes, mnemonics, and
machine cycle times. Switch between debugging at machine-code level and source-code level by
simply opening or closing the disassembly window.

» Wiatch expressions—Watch expressions are compiled when defined, so complex expressions
including function calls may be placed into watch expressions. Watch expressions can be updated
with or without stopping program execution.

» Register window—All processor registers and flags are displayed. The contents of general registers
may be modified in the window by the user.

» Stack window—shows the contents of the top of the stack.
» Hex memory dump—displays the contents of memory at any address.

» STDIO window—printf outputs to this window and keyhoard input on the host PC can be
detected for debugging purposes. printf output may also be sent to a serial port or file.
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5.2 Dynamic C Functions

The functions described in this section are for use with the Prototyping Board features.
The source code is in the RCM37xx . L1B library in the Dynamic C SAMPLES\RCM3700 or
the SAMPLES\RCM3720 folder, depending on which Prototyping Board you will be using,
if you need to modify it for your own board design.

Other generic functions applicable to all devices based on Rabbit microprocessors are
described in the Dynamic C Function Reference Manual.
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5.2.1 Board Initialization

void brdInit (void);

Call this function at the beginning of your program. This function initializes Parallel Ports A through G
for use with the RCM3700 Prototyping Board or the RCM3720 Prototyping Board.

The brdInit function is set up to a default 1/0 configuration based on the RabbitCore module detected
at compile time:

* Any RCM3700 RabbitCore module (except the RCM3720) will have its 1/0 ports configured for an

RCM3700 Prototyping Board.

* An RCM3720 RabbitCore module will have its 1/0 ports configured for an RCM3720 Prototyping

Board.

You may override these default settings to run an RCM3720 RabbitCore module on the RCM3700 Proto-
typing Board or to run another RCM3700 RabbitCore module on the RCM3720 Prototyping Board by
adding the following macro to the program you will be running.

To run an RCM3720 RabbitCore module on an RCM3700 Prototyping Board, add the following
macro at the top of the program you will be running.

#define RCM3700_PROTOBOARD

Sample programs that are specifically designed for the RCM3700 Prototyping Board already have
this macro included. When you run a sample program designed for the RCM3700 Prototyping
Board on an RCM3720, a warning message will be displayed to inform you of that. You can disable
the warning by commenting out the line indicated by the compiler.

To run an RCM3700 RabbitCore module (other than the RCM3720) on an RCM3720 Prototyping
Board, add the following macro at the top of the program you will be running.

#define RCM3720_PROTOBOARD

Summary of Initialization

=

© o N RN

1/0 port pins are configured for Prototyping Board operation.

Unused configurable 1/O are set as tied inputs or outputs.

The LCD/keypad module is disabled.

RS-485 is not enabled.

RS-232 is not enabled.

The IrDA transceiver is disabled.

LEDs are off.

The A/D converter is reset and SCLKB is to 57,600 bps (RCM3700 Prototyping Board only).

The A/D converter calibration constants are read (this function cannot run in RAM) (RCM3700
Prototyping Board only).

. Ethernet select is disabled.
11.

Serial flash select is disabled.

CAUTION: Pin PB7 is connected as both switch S2 and as an external 1/0O bus on the RCM3700
Prototyping Board. Do not use S2 when the LCD/keypad module is installed.

CAUTION: Pins PC1 and PG2 are tied together, and pins PC3 and PG3 are tied together on the
RCM3700 RabbitCore module. Both pairs of pins are connected to the IrDA transceiver and to
the RS-232 transceiver via serial ports on the RCM3700 Prototyping Board. Do not enable both
transceivers on the RCM3700 Prototyping Board at the same time.

RETURN VALUE
None.
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5.2.2 Analog Inputs

NOTE: The function calls for the A/D converter in this section will work only with the
RCM3700 Prototyping Board.

unsigned int analnConfig(unsigned iInt

instructionbyte, unsigned int cmd,

long baud);

Use this function to configure the ADS7870 A/D converter. This function will address the ADS7870 in
Register Mode only, and will return error if you try the Direct Mode. Section B.1.5 provides additional
addressing and command information for the ADS7870 A/D converter.

ADS7870 Signal | ADS7870 State RCM3700 Function/State

LNO Input AINO
LN1 Input AIN1
LN2 Input AIN2
LN3 Input AIN3
LN4 Input AIN4
LN5 Input AIN5
LN6 Input AIN6
LN7 Input AIN7

/IRESET Input Board reset device

RISE/FALL Input Pulled up for SCLK active on rising edge
P100 Input Pulled down
PIO1 Input Pulled down
P102 Input Pulled down
P103 Input Pulled down
CONVERT Input Pulled down
BUSY Output PD1 pulled down; logic high state converter is busy
CCLKCNTRL Input Pulled down; 0 state sets CCLK as input

CCLK Input Pulled down; external conversion clock

SCLK Input PBO; serial data transfer clock
SDI Input PD4; 3-wire mode for serial data input
SDO Output PD5; serial data output /CS driven
/CS Input PD2 pulled up; active-low enables serial interface

BUFIN Input Driven by VREF; reference buffer amplifier

VREF Output Connected to BUFIN

BUFOUT Output VREF output
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PARAMETERS

instructionbyte is the instruction byte that will initiate a read or write operation at 8 or 16 bits on
the designated register address. For example,

checkid = analnConfig(Ox5F, 0, 9600); // read ID and set baud rate

cmd refers to the command data that configure the registers addressed by the instruction byte. Enter 0 if
you are performing a read operation. For example,

i = analnConfig(0x07, Ox3b, 0); // write ref/osc reg and enable

baud is the serial clock transfer rate of 9600 to 57,600 bps. baud must be set the first time this function
is called. Enter O for this parameter thereafter, for example,

analnConfig(0x00, 0x00, 9600); // resets device and sets baud
RETURN VALUE

0 on write operations,
data value on read operations

SEE ALSO
analnDriver, analn, brdilnit
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unsigned int analnDriver(unsigned int cmd,
unsigned int len);

Reads the voltage of an analog input channel by serial-clocking an 8-bit command to the ADS7870 A/D
converter by the Direct Mode method. This function assumes that Model (most significant byte first) and
the A/D converter oscillator have been enabled. See analnConfig() for the setup.

The conversion begins immediately after the last data bit has been transferred. An exception error will
occur if Direct Mode bit D7 is not set.
PARAMETERS
cmd contains a gain code and a channel code as follows.
D7—1; D6-D4—Gain Code; D3-D0—Channel Code
Use the following calculation and the tables below to determine cmd:

cmd = 0x80 | (gain_code*16) + channel_code

Gain Code Multiplier
0 x1

X2

x4

X5

x8

x10

x16

x20

~N| oo~ W N

Channel Code Differi?r::’lsl Input Channel Code SIangL:f_LEi:Z? 4~inger2A
0 +AINO -AIN1 8 AINO AINO*
1 +AIN2 -AIN3 9 AIN1 AIN1*
2 +AIN4 -AIN5 10 AIN2 AIN2*
3f +AING -AIN7 11 AIN3 AIN3
4 -AINO +AIN1 12 AIN4 AIN4
5 -AIN2 +AIN3 13 AIN5 AIN5
6 -AIN4 +AINS 14 AING AING
Ve -AIN6 +AIN7 15 AIN7 AINT7*

* Negative input is ground.
t Not accessible on RCM3700 Prototyping Board

len, the output bit length, is always 12 for 11-bit conversions

RETURN VALUE
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A value corresponding to the voltage on the analog input channel:

0-2047 for 11-bit conversions (bit 12 for sign)
-1 overflow or out of range
-2 conversion incomplete, busy bit timeout

SEE ALSO
analnConfig, analn, brdInit
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unsigned int analn(unsigned int channel,
Int gaincode);

int opmode,

Reads the value of an analog input channel using the direct method of addressing the ADS7870 A/D
converter. The A/D converter is enabled the first time this function is called—this will take approxi-
mately 1 second to ensure that the A/D converter capacitor is fully charged.

PARAMETERS

channel is the channel number (0 to 7) corresponding to ADC_INO to ADC_IN7
opmode is the mode of operation:

SINGLE—single-ended input
D I FF—differential input
MAMP—4-20 mA input

channel SINGLE DIFF mAMP
0 +AINO +AINO -AIN1 +AINO”
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AINS -AIN4* +AIN5
6 +AING +AING -AIN7* +AING
7 +AIN7 +AIN7 -AING6* +AIN7*

* Not accessible on RCM3700 Prototyping Board.

gaincode is the gain code of 0 to 7

Gain Code | Multiplier | Voltage Range’

V)

0 x1 0-20

1 X2 